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Preface
The Oracle Insurance Insight Installation Guide provides instructions for installing and 
configuring Oracle Insurance Insight (OII) V7.0 and all required prerequisite software.

VERSION
This manual corresponds to Oracle Insurance Insight (OII) version 7.0.

INTENDED AUDIENCE
This manual is intended for users and administrators with knowledge of the insurance 
industry.

RELATED OII DOCUMENTATION
For more information, refer to the following documents:

• Oracle Insurance Insight Release Notes

• Oracle Insurance Insight Warehouse Palette User Guide

• Oracle Insurance Insight Implementation Guide

• Oracle Insurance Insight Administration Guide

• Oracle Insurance Insight User Guide
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vi

OII DOCUMENTATION ON THE ORACLE TECHNOLOGY NETWORK 
(OTN)

The OII documentation set is packaged with the product release. You can also obtain these 
guides online thought the Oracle Technology Network (OTN) at this address:
http://www.oracle.com/technetwork/documentation/insurance-097481.html

CUSTOMER SUPPORT
If you need help with OII, please log a Service Request using My Oracle Support at”
https://support.oracle.com
Address any additional inquiries to:
Oracle Corporation
World Headquarters
500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200
oracle.com
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Chapter 1

System Information

CONFIGURATION AND INSTALLATION REQUIREMENTS

REQUIRED INFORMATION
You must have the following information on hand for the OII installation:

• Oracle Database server name or IP Address

• Oracle Database host name

• Oracle Database user name/password

The Domain user account which will have Administrator privilege on local machine and 
database access rights on the database server.

ADMINISTRATOR PRIVILEGES
The user must log in with the Domain user account mentioned above on the machine on 
which you are installing OII.

DATABASE SERVER ENVIRONMENT

Operating Systems:

• Windows Server 2003 or HP-UX 11 iv3

Prerequisite Software:

• Oracle Database 11g

Hardware Requirements:

• CPU: (4) 2GHz processors or higher

• RAM: 8GB or higher
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APPLICATION SERVER ENVIRONMENT

Operating Systems:
Windows Server 2003 or HP-UX 11 iv3

Prerequisite Software:

• Oracle Database Client 11g

• Oracle WebLogic Application Server 11g

• Oracle JDeveloper 11g

• Oracle Business Intelligence Enterprise Edition 10.1.3.4.1 or higher

• Oracle Data Integrator 11g

• Oracle Application Express Release 4

• JDK 1.6.0

• 7-Zip

Hardware Requirements:

• CPU: 2GHz or higher

• RAM: 2GB or higher

• Disk Space: 6.5GB 

• Temporary Disk Space: 4GB

Web Browser:

• Microsoft Internet Explorer Version 7.0 or later

• Mozilla Firefox 3.5 or later
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Chapter 2 

Installing Oracle Database Client
Required Version: Oracle Database Client 11g
Download: To download Oracle Database Client, enter the following URL in your browser:
http://www.oracle.com/technetwork/database/enterprise-edition/downloads/index.html

Documentation: This chapter is not a complete installation guide for Oracle Database 
Client 11g. It is provided to guide you through the Oracle Database Client installation 
process and select the options that are best suited for use with OII. 
The full Oracle Database Client documentation set can be found at:
http://www.oracle.com/technetwork/database/enterprise-edition/documentation/index.html
The high-level instructions for installing and configuring Oracle Database Client 11g 
consists of these steps:

STEP 1: DOWNLOAD ORACLE DATABASE CLIENT 11G
1. Create a temporary directory on your computer where you can download the Oracle 

Database Client installation file (e.g., temp_client).

2. Load the following URL into your browser to open the Oracle Database Software 
Downloads page: 
 
http://www.oracle.com/technetwork/database/enterprise-edition/downloads/index.html

3. Under the section, Oracle Database 11g Release 2, click on the “See All” link next to 
the relevant platform for your system. The Downloads page for Oracle Database 11g 
Release 2 will open.

4. Click “Accept License Agreement” at the top of the page.

Table 1: Installation Road Map

Step Description

Step 1 Download Oracle Database Client

Step 2 Install Oracle Database Client

Step 3 Create a Client Connection with Net Manager

http://www.oracle.com/technetwork/database/enterprise-edition/documentation/index.html
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5. Go to the Oracle Database 11g Release 2 Client section, (e.g., Oracle Database 11g 
Release 2 Client (11.2.x) for Microsoft Windows (32-bit)), and click on the ZIP file 
link for the Oracle Database Client (e.g., win32_11gR2_client.zip).

6. Follow the instructions on the screen to go through the registration process and download 
the Oracle Database Client ZIP file to the temporary directory on your computer. 

7. Go to the temporary directory and use the 7-Zip utility to extract the contents of the 
Oracle Database Client ZIP file. This will create a directory bearing the name of the ZIP 
file under the temporary directory.(e.g., c:\temp_client\win32_11gR2_client).

STEP 2: INSTALL ORACLE DATABASE CLIENT 11G
1. Locate the setup.exe file in the directory where you extracted the Oracle Database Client 

ZIP files in the previous section. This file will be usually located in the client directory 
under the unzipped directory  
 
(e.g., C:\temp_client\win32_11gR2_client\setup.exe).

2. Double-click setup.exe. The Oracle Universal Installer will launch. The first screen in the 
installer will be the Select Installation Type screen. 

Figure 1: Select Installation Type Screen

3. Select Administrator as the installation type. 
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4. Click Next. The Select Product Languages screen opens. 

Figure 2: Select Product Languages Screen

5. Select the language in which you want to run the product (English is the selected default).

6. Click Next. The Specify Installation Location screen opens. 

Figure 3: Specify Installation Location Screen

7. Accept the defaults for the installation directories or specify different ones as you see fit.
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8. Click Next. The Perform Prerequisite Checks screen verifies that your computer meets 
the minimum system requirements. 

• If it does not, it will list the prerequisites that have failed. 

• If all prerequisites are successful then you will be transferred to the Summary 
screen.

Figure 4: Summary Screen

9. Click Finish to start the installation. The Install Product Screen will appear and let you 
follow the progress of the installation. Note that the installation may take a while. 

Figure 5: Install Product Screen
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10. When the installation has finished, the Finish screen will appear.

Figure 6: Finish Screen

11. Click Close to close the installer.
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STEP 3: CREATE A CLIENT CONNECTION
1. Open Net Manager by selecting:  

All Programs >Oracle – OraClient11g_home1>Configuration and Migration 
Tools>Net Manger

Figure 7: Oracle Net Manager Welcome Screen

2. In the menu on the left, expand the Local node and highlight the Service Naming node.

3. Click the ‘+’ button to the left of the menu tree. The Net Service Wizard: Welcome 
screen appears.
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4. Enter a Net Service Name. The name may be any name you choose. For this example 
we will use Insight700 as the Net Service Name.

Figure 8: Welcome Screen

5. Click on Next. The Protocol screen opens.

Figure 9: Protocol Screen
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6. Keep the default selection (“TCP/IP (Internet Protocol)”) and click on Next. The 
Protocol Settings screen opens.

Figure 10: Protocol Settings Screen

7. Enter the following settings on the Protocol Settings screen:

• Host Name: Enter the host name or address where the Oracle database server is 
located.

• Port Number: Keep 1521 as the default. This is the standard default for Oracle 
databases.

8. Click Next. The Service screen opens. 

Figure 11: Service Screen
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9. Specify the following settings on the Service Name screen:

• Service Name: The Service Name name of the database you wish to access. For this 
example we will use the orcl as the Service Name.

• Connection Type: Accept Database Default (this is the default selection).

10. Click on Next. The Test screen opens.

Figure 12: Test Screen
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11. Click on the Test button to test the database connection. Net Manager will first attempt 
to connect to the database using the default username and password (scott/tiger) and it 
will return an error message.

Figure 13: Connection Test Failed

12. Click on the Change Login button. A dialog box will appear in which you can specify a 
username and password that you know exists.

Figure 14: Change Login
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13. Click OK to close the Change Login dialog box.

14. Click the Test button. A message indicating a successful connection will appear on the 
screen:

Figure 15: Connection Test Successful

15. Click the Close button to close the Connection Test screen.
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16. Click on Finish on the Test screen. The main Net Manager screen opens and the 
connection you just created ill appear under the Service Naming folder.

Figure 16: The New Connection Appears Under Service Naming Folder

17. Click on File>Save Network Configuration to save the connection.

18. Select File>Exit to close the screen.

WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step in the installation process is to install WebLogic and JDeveloper. Go to:

• Chapter 3: Installing Oracle WebLogic Server and Oracle JDeveloper
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Chapter 3

Installing Oracle WebLogic Server and 
Oracle JDeveloper
This chapter describes how to install and configure Oracle WebLogic Server 11g and Oracle 
JDeveloper 11g. 

Download: WebLogic is bundled with the JDeveloper installation file, allowing you to 
download and install both applications simultaneously. 

The JDeveloper 11.1.1.3.0 installation file can be downloaded from the Oracle Technology 
Network at the following URL:

http://www.oracle.com/technetwork/developer-tools/jdev/downloads/archives-090457.html

Documentation: This chapter is not a complete installation guide for WebLogic or 
JDeveloper. It is provided to guide you through the installation process for both applications 
and select the recommended options that are best suited for use with OII. 
The full WebLogic documentation set can be found at:
http://www.oracle.com/technetwork/middleware/weblogic/documentation/index.html
The full JDeveloper documentation set can be found at:
http://www.oracle.com/technetwork/developer-tools/jdev/documentation/index.html
The high-level instructions for installing and configuring WebLogic and JDeveloper consists 
of these steps:

Note JDeveloper 11.1.1.3.0 is required for use with OII. 

Table 2: Installation Road Map

Step Description

Step 1 Download the JDeveloper Installation File

Step 2 Install JDeveloper/WebLogic

Step 3 Create a WebLogic Domain

Step 4 Start the WebLogic Administration Console

http://www.oracle.com/technetwork/middleware/weblogic/documentation/index.html
http://www.oracle.com/technetwork/developer-tools/jdev/downloads/archives-090457.html


Chapter 3 – Installing Oracle WebLogic Server and Oracle JDeveloper

16

STEP 1: DOWNLOAD THE JDEVELOPER INSTALLATION FILE
1. Create a temporary directory on your computer to which to download the JDeveloper 

installation file (e.g., C:\temp\jdeveloper).

2. Load the following URL into your browser to open the Archives page for JDeveloper:

http://www.oracle.com/technetwork/developer-tools/jdev/downloads/archives-090457.html

3. Accept the License Agreement at the top of the page.

4. Click on the Oracle JDeveloper 11g 11.1.1.30 link and follow the instructions on the 
screen to go through the registration process and download the JDeveloper installation 
file to the temporary folder on your computer. Note that although the JDeveloper 
installation file is an executable file it has no .EXE extension (e.g., 
jdevstudio11113install). 

5. Once the download is complete, rename the JDeveloper installation file and add an .EXE 
extension.

STEP 2: INSTALL JDEVELOPER/WEBLOGIC
1. Go to the folder where you downloaded the JDeveloper installation file and double-click 

it to launch the installer:

Figure 17: JDeveloper Installer Welcome Screen

http://www.oracle.com/technetwork/developer-tools/jdev/downloads/archives-090457.html
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2. Click Next. The Choose Middleware Home Directory screen appears.

Figure 18: Choose Middleware Home Directories

3. Accept the existing default directory option or enter a new Middleware home directory. 
This will be the root directory under which WebLogic and JDeveloper will be installed.

4. Click Next. The Choose Install Type screen opens.

Figure 19: Choose Install Type



Chapter 3 – Installing Oracle WebLogic Server and Oracle JDeveloper

18

5. Select the “Custom” installation type.

Figure 20: Select the “Custom” Install Type

6. Click Next. The Choose Products and Components screen opens. 

Figure 21: Choose Products and Components
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7. On this screen select the following components:

• Application Development Framework Runtime

• All WebLogic Server components

8. De-select JDeveloper Studio. The selections on the screen will look like this:

Figure 22: Select ADF and All WebLogic Server Components
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9. Click Next. The JDK Selection screen opens. 

Figure 23: JDK Selection Screen

10. Make sure that the JDK is selected (e.g., SUN SDK 1.6.0_18). By default it should be 
selected. 

Note The actual JDK version you see will likely be different then the one shown in Figure 23.
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11. Click Next. The Confirm Product Installation Directories screen appears.

Figure 24: Confirm Product Installation Directories 

12. Confirm the installation directories and click Next. The Install Windows Service screen 
opens.

Figure 25: Install Windows Screen
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13. Select No (the default) and click Next. The Choose Shortcut Location screen opens.

Figure 26: Choose Shortcut Location

14. Select “All Users” Start Menu folder (the default) and click Next. The Installation 
Summary screen opens.

Figure 27: Installation Summary
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15. Click Next. The installation will begin and a progress screen will appear to allow you to 
follow its progress.

Figure 28: Progress Screen

16. When the Installation Complete screen appears click on Done to close the installer.

Figure 29: Installation Complete
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STEP 3: CREATE A WEBLOGIC DOMAIN
1. Start the Configuration Wizard:

For Windows:

• Launch the Configuration Wizard from the Start Menu by choosing:  
 
Start Menu>All Programs>Oracle Fusion Middleware 11.1.1.x>WebLogic 
Server 11gR1>Tools>Configuration Wizard

For HP-UX:

• Open a command shell and execute the following command:

{WLHOME}/common/bin/ sh config.sh

The Configuration Wizard Welcome screen opens:

Figure 30: Welcome Screen

2. Keep the default, Create a new WebLogic domain, and click Next. The Select Domain 
Source screen opens.
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3. On the Select Domain Source screen:

a. Keep the default selection: Generate a domain configured automatically to 
support the following products:

b. Check Oracle JRF - 11.1.1.x (oracle_common). This is the name of the 
Application Development Framework (ADF) Runtime libraries.

Figure 31: Select Domain Source

4. Click Next. The Specify Domain Name and Location screen opens:

Figure 32: Specify Domain Name and Location
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5. On this screen, enter the following components:

• Domain Name - The domain name can be any name that meets your company 
standards. The default name that appears when you arrive is “base_domain”.

• Domain Location -The location where your domain is stored. The location shown 
here is the default directory. Accept this location or enter a new one.

6. Click Next. The following screen opens:

Figure 33: Configure Administrator Name and Password

7. On this screen, enter the following information:

• User Name - Enter a readily identifiable user name for the WebLogic Administrator 
account for the domain (e.g., oii_domain). The default user name is “weblogic” but 
you can select whatever name you wish.

• User Password - Enter a password for the WebLogic Administrator account for the 
domain.

• Confirm User Password - Retype the password.

• Description - Accept the default description or enter a alternative description.

Note Remember the user name and password that you enter here. You will need it for future 
maintenance including logging into the WebLogic Administration Console. 
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8. Click Next. The following screen opens:

Figure 34: Configure Server Start Mode and JDK

9. On this screen, make sure that the following items are selected (both these items are the 
default selections on this screen):

• Choose Development Mode 

• Select the Sun SDK as the JDK (the actual JDK version you see will likely be different 
then the one shown in Figure 34).
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10. .Click Next. The following screen opens:

Figure 35: Select Optional Configuration

11. Do not select any option on this screen. They are not required. 

12. Click Next. The following screen opens:

Figure 36: Configuration Summary
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13. Review the summary information and click Create. The following screen opens:

Figure 37: Creating Domain Progress Screen

14. When the progress bar displays 100% click Done to close the Wizard. The domain is 
ready to use. 

STEP 4: START THE WEBLOGIC ADMINISTRATION CONSOLE

Start the WebLogic Server and log into the WebLogic Administration Console to test the 
installation.

1. From the Start Menu select:

Start>All Programs>Oracle WebLogic>User Projects><Your Server 
Domain>>Start Admin Server for WebLogic Server Domain

Note To start WebLogic under HP-UX, follow the instructions in To start WebLogic under HP-
UX: on page 30.
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A separate window will open and display a series of messages to indicate that the domain 
server is up and running.

3. Once the WebLogic server domain is running, select: 
 
Start>All Programs>Oracle WebLogic>User Projects><Your Server 
Domain>>Admin Server Console

The WebLogic Server Administration Console login screen will open:

Figure 38: WebLogic Server Administration Console Login Screen

Note To start WebLogic under HP-UX:

1. Go to the domain for which you want to start the WebLogic:

$ cd /oracle/middleware/user_projects/domains/ 
<your server domain>

for example:

$ cd /oracle/middleware/user_projects/domains/oii_domain

2. Type:

$ nohup startWebLogic.sh &
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4. Enter the administrator user name and password for the domain that you specified when 
you created the domain (see Step 3: Create a WebLogic Domain on page 26). The 
WebLogic administration console opens:

Figure 39: WebLogic Server Administration Console

5. The appearance of the WebLogic Server Administration Console indicates that the 
WebLogic installation has been successful.
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6. Click on Deployments in the pane on the left. The Summary of Deployments screen 
opens.  
 
The appearance of the Application Development Framework Runtime libraries in the 
Deployments table indicates that they have been successfully installed to WebLogic.

Figure 40: Application Development Framework Runtime Libraries

WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step in the installation process is to install Oracle Data Integrator 11g. Go to:

• Chapter 4: Installing Oracle Data Integrator (ODI)
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Chapter 4

Installing Oracle Data Integrator (ODI)
Required Version: Oracle Data Integrator 11g

Download: To obtain the required version of Oracle Data Integrator (ODI) on the Oracle 
Technology Network, enter the following URL in your browser:
http://www.oracle.com/technetwork/middleware/data-integrator/downloads/index.html

Documentation:  This chapter is not a complete installation guide for ODI but rather is 
intended to guide you through the ODI installation process and select the recommended 
options that are best suited for use with OII.
The full Oracle Data Integrator 11g documentation suite can be found at:
http://www.oracle.com/technetwork/middleware/data-integrator/documentation/index.html
The high-level instructions for installing and configuring ODI consist of these steps.

Table 3: Installation Road Map

Step Description

Step 1 Download ODI

Step 2 Install ODI
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STEP 1: DOWNLOAD ODI
1. Create a temporary directory on your computer to which to download the ODI 

installation file (e.g., C:\temp\ODI).

2. Load the following URL into your browser to open Oracle Data Integrator Downloads 
page:

http://www.oracle.com/technetwork/middleware/data-integrator/downloads/index.html

3. Accept the license agreement at the top of the page.

4. Under the section, Oracle Data Integrator 11g, click on the link for the appropriate 
platform’s installation package. 

5. Follow the instructions on the screen to go through the registration process and download 
the ODI installation .ZIP file to the temporary directory on your computer.

6. Once the download is complete, locate the .ZIP file and extract the contents of the file 
using 7-Zip. This will create a directory bearing the same name as the .ZIP file. Beneath 
this directory will be two folders: Disk1 and Disk2.

STEP 2: INSTALL ODI
1. Open the Disk1 folder and double-click setup.exe to launch the installer. The Welcome 

screen opens.

Figure 41: ODI Welcome Screen
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2. Click Next. The Select Installation Type screen appears.

Figure 42: Select Installation Type

3. Select Standalone Installation and make sure that the ODI Studio is checked. You will 
need ODI Studio to configure the Master and Work Repositories after you install ODI. 
Do not select any other components on this screen.

Important The Standalone Installation is the installation type that Oracle recommends for use 
with OII. The steps and screens in this section describe a typical Standalone Installation.
You can, of course, select either of the other installation types on this screen but be 
aware that the sequence of screens will be different depending upon your choice. There 
will also be additional post-installation configuration steps for these installation types.
For a complete description of the steps for these installation types, refer to:
• Oracle Fusion Middleware Installation Guide for Oracle Data Integrator 11g
This manual is available along with the complete ODI documentation set:
http://www.oracle.com/technetwork/middleware/data-integrator/documentation/
index.html
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4. Click Next. The Prerequisite Checks screen appears. 
 
If there are problems with the prerequisites, an error message will appear in the area at 
the bottom of the screen. Fix the error, and click Retry to try again.

Figure 43: Prerequisite Checks
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5. Once green check marks appear for all prerequisites appear under the “Status”, click 
Next. The Specify Installation Location screen opens.

Figure 44: Specify Installation Location

6. Accept the default path displayed here or use the Browse button to enter a new absolute 
path for the ODI home directory.

7. Click Next. The Repository Configuration screen opens.
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8. Select Skip Repository Configuration. The task list on the right will refresh to remove 
all configuration steps.

Figure 45: Select “Skip Repository Configuration”
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9. Click Next. The Specify Agent Details screen opens.

Figure 46: Specify Agent Details

10. Enter the following 

• Agent Name - Provide an alphanumeric name of your choice for the ODI standalone 
or local agent.

• Agent Port - Provide a port number between 1024 and 65535 that is not currently 
being used by any other Oracle home. This port defaults to 20910.
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11. Click Next. The Specify Security Updates screen opens.

Figure 47: Specify Security Updates

12. Specify whether or not you want to receive security updates.
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13. Click Next. The Installation Summary screen opens.

Figure 48: Installation Summary
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14. Review the information on this screen and click Install to start the installation. The 
Installation progress screen opens. This screen lets you follow the progress of the 
installation. 

Figure 49: Installation Progress
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15. The Configuration Progress screen will appear to show the progress of the various 
component configurations.

Figure 50: Configuration Progress

16. Click Next. When the installation has completed successfully, the following screen 
opens.

Figure 51: Installation Completed
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17. Click Finish to close the installer.

WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step in the installation process is to install Oracle Business Intelligence Enterprise 
Edition (OBIEE) 10.1.3.4.x. Go to:

• Chapter 5: Installing Oracle Business Intelligence Enterprise Edition
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Chapter 5

Installing Oracle Business Intelligence 
Enterprise Edition
Required Version: Oracle Business Intelligence Enterprise Edition (OBIEE) 10.1.3.4.x

Download:  To download the required version of OBIEE from the Oracle Technology 
Network, enter the following URL in your browser:
http://www.oracle.com/technetwork/middleware/bi-enterprise-edition/downloads/
index.html

Documentation: This chapter is not a complete installation guide for OBIEE but rather is 
intended to guide you through the OBIEE installation and configuration process and select 
the recommended settings that are best suited for use with OII.
The full OBIEE documentation set can be found at:
http://www.oracle.com/technetwork/middleware/bi-enterprise-edition/overview/index.html
The high-level instructions for installing and configuring OBIEE consists of these steps:

STEP 1: DOWNLOAD OBIEE
1. Create a temporary directory on your computer to which to download the OBIEE 

installation file (e.g., C:\temp\obiee). 

2. Load the following URL into your browser to open the Oracle Business Intelligence 
Downloads page.

http://www.oracle.com/technetwork/middleware/bi-enterprise-edition/downloads/
index.html

3. Select the “Oracle Business Intelligence 10g downloads” link. The Oracle 
Business Intelligence (10.1.3.x) Downloads page will open.

4. Accept the license agreement at the top of the page.

Table 4: Installation Road Map

Step Description

Step 1 Download OBIEE

Step 2 Install OBIEE
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5. Click on the link for the appropriate platform’s installation package. 

6. Follow the instructions on the screen to go through the registration process and download 
the OBIEE installation .ZIP file to the temporary directory on your computer.

7. Once the download is complete, locate the .ZIP file and extract the contents of the file 
using 7-Zip. This will create a directory bearing the same name as the .ZIP file.

STEP 2: INSTALL OBIEE 10.1.3.4.X

1. Go to the directory where you extracted the contents of the .ZIP file and locate the 
setup.exe file. This file should be located under: 

<OBIEE Temp Directory>\Windows\Server\Oracle_Business_Intelligence\setup.exe

For example:

C:\temp\obiee\biee_windows_x86_101341\Windows\Server\Oracle_Business_Intellige
nce\setup.exe

2. Double-click setup.exe to launch the installer. The following screen appears:

Figure 52: Installer Welcome Screen  

Note The following instructions are based on Microsoft Windows x86 installation.
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3. Click Next. The following screen appears:

Figure 53: Select the Location for OBIEE

4. Accept or change the default Installation Location and the Data Location as you wish:

• The default installation location is C:\OracleBI. 

• The default Data Location is C:\OracleBIData. 

5. Select the “Basic” installation type:  

• “Basic: Minimum security. Installs Oracle Containers for J2EE (OC4J)”
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6. Click on Next. The following screen appears:

Figure 54: Select the “Complete” Installation

7. Accept the default setup type, which is “Complete”, and click Next. The following 
screen appears. 

Figure 55: Enter the JDK Location and Administrator Password
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8. Enter the following information on this screen:

a. The directory where Java JDK 1.6.0 or higher is installed on your system. 
In Figure 56 the location of the JDK is “C:\Oracle\Middleware\jdk160_21\”. This happens 
to be the default directory where the JDK was installed when you installed JDeveloper 
and WebLogic. 

b. An ocj4 Administrator password of your own choosing.

Figure 56: JDK Location and Password Entries

Note The actual JDK version may be different for you.

IMPORTANT Remember this password. You will need it later on to perform Administrative tasks in 
OBIEE.
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9. Click Next. The Oracle BI Services screen appears. 

Figure 57: Oracle BI Services Screen

10. Do not enter anything on this screen. Simply click Next. The following screen appears. 

Figure 58: Error Message Language Selection Screen
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11. Select the Error Message Language from the drop-down list and click Next. The 
Summary screen shows:

Figure 59: OBIEE Summary Screen

12. Click Next. Before the installer starts to install OBIEE, it will try to install the Microsoft 
.Net Framework 2.0 in a separate window. If you already have this or a later version 
installed, you can click on Cancel. Otherwise, click on Next. Once that finishes, the 
installer starts the real installation of OBIEE. This will take a while, so please be patient.

Figure 60: Installation Progress Screen
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13. Once the initial installation is complete the installer will give you this message before it 
ends:

Figure 61: Installation Successful

14. Click Next. The Installation Summary screen appears to inform you that the 
installation was a success.

Figure 62: Installation Summary for a Successful Installation
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15. Click Next. The final step is to restart your computer for some of the updates. 

Figure 63: Restart your Computer to Complete the Installation

16. Select the Yes radio button and then select Next to restart your computer. 

WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step in the installation process is to install Oracle Application Express. Go to:

• Chapter 6: Installing Oracle Application Express
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Chapter 6

Installing Oracle Application Express
Required Version:  Oracle Application Express (APEX) Release 4.0

Download: To download the required version of APEX, enter the following URL in your 
browser:
http://www.oracle.com/technetwork/developer-tools/apex/downloads/index.html

Documentation: This chapter is not a complete installation guide for APEX but rather is 
intended to guide you through the APEX installation process and select the recommended 
options that are best suited for use with OII
The full documentation set for APEX can be found at:
http://www.oracle.com/technetwork/developer-tools/apex/documentation/index.html
The high-level instructions for installing and configuring APEX consists of these steps:

STEP 1: CHOOSE HTTP SERVER OPTION FOR THE INSTALLATION
You will need to decide beforehand which HTTP Server option to choose with APEX. In 
order to run, APEX requires access to one of the following:

• Oracle Application Express Listener

• Embedded PL/SQL gateway

• Oracle HTTP Server and mod_plsql

The post-installation configuration steps for APEX will be different depending on which 
HTTP Server you choose. Consult the Oracle Application Express Installation Guide 4.0 for 
an explanation of each HTTP Server option and which one best suits your needs.

Table 5: Installation Road Map

Step Description

Step 1 Choose the HTTP Server Option for the Installation

Step 2 Download APEX

Step 3 Install APEX

Step 4 Change the Password for the ADMIN Account
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STEP 2: DOWNLOAD APEX
1. Create a temporary directory on your computer to which to download the APEX 

installation file (e.g., C:\temp\apex).

2. Load the following URL into your browser to open the Oracle Application Express 
Downloads page.

http://www.oracle.com/technetwork/developer-tools/apex/downloads/index.html

3. Accept the license agreement at the top of the page.

4. Click on the “Download” link of the most recent version of APEX 4.0 (you may select 
the English or All Language option).

5. Follow the instructions on the screen to go through the registration process and download 
the APEX installation .ZIP file to the temporary directory on your computer.

6. Once the download is complete, locate the .ZIP file and extract the contents of the file 
using 7-Zip. This will create a directory bearing the same name as the .ZIP file. Directly 
beneath this directory is a directory called apex.

STEP 3: INSTALL APEX
1. Open a command prompt and change your working directory to the apex directory.

2. At the command line, start SQL*Plus and connect to the database as SYS specifying the 
SYSDBA role. 

In this case, connect to the database using the Net Service Name that you created in 
Chapter 2: Installing Oracle Database Client when you ran Step 3: Create a Client 
Connection on page 8 (recall that the sample Net Service Name in that chapter was 
Insight700). For example:

Output similar to the following is displayed on the screen and you will be prompted for 
the password for SYS:

Note For this particular installation of APEX, we strongly recommend you select the 
Oracle Application Express Listener.

> sqlplus sys@Insight700 as sysdba 

> SQL*Plus: Release 10.2.0.1.0 Production on Fri Jan 14 15:29:19 2011

> Copyright (c) 1982, 2010, Oracle.  All rights reserved.

> Enter password:
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3. Enter the password for SYS.

4. The SQL prompt will appear 
:

5. Run the apexins.sql command to install APEX while passing the following four 
arguments in the order shown:

Where:

• tablespace_apex is the name of the tablespace for the Oracle Application Express 
application user.

• tablespace_files is the name of the tablespace for the Oracle Application Express 
files user.

• tablespace_temp is the name of the temporary tablespace.

• images is the virtual directory for Oracle Application Express images. To support 
future Oracle Application Express upgrades, define the virtual image directory as /i/.

Example:

As APEX is installed, a series of progress messages will appear on the screen. When the 
installation is complete, the connection to SQL*Plus will close. The SQL> prompt will 
disappear and you will be returned to your command line.

SQL>

SQL> @apexins tablespace_apex tablespace_files tablespace_temp images

SQL> @apexins SYSAUX SYSAUX TEMP /i/
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STEP 4: CHANGE THE PASSWORD FOR THE ADMIN ACCOUNT
In a new installation of Oracle Application Express you must change the password of the 
internal ADMIN account. In an upgrade scenario, the password will be preserved and carried 
over from the prior release.
To change the password for the ADMIN account:

1. Change your working directory to the apex directory where you unzipped the installation 
software.

2. Restart SQL*Plus and reconnect to the database where Oracle Application Express is 
installed as SYS specifying the SYSDBA role (just as you did in Step 2: Download 
APEX on page 56). 

3. Run apxchpwd.sql. For example: 

When prompted enter a password for the ADMIN account.

WHAT’S THE NEXT STEP IN THE INSTALLATION?
Once APEX has been installed you are ready to install the Oracle Insurance Insight 
application. For these steps, go to:

• Chapter 7: Installing Oracle Insurance Insight

SQL> @apxchpwd
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Chapter 7

Installing Oracle Insurance Insight
This chapter describes the steps for installing Oracle Insurance Insight (OII) to your system. 

Installation Prerequisites
Before you can begin the installation you must have the following information available:
• Oracle Database server name or IP Address
• Oracle database Host Name
• Oracle database SID or Service Name
• Oracle database Port number
• Oracle database user name and password

INSTALL OII
OII is available from the Oracle E-Delivery system as a downloaded .ZiP file:
http://edelivery.oracle.com/

1. Obtain the OII installation ZIP file from Oracle E-Delivery and download it to a 
temporary folder on your machine (i.e. C:\temp).

2. Unzip the file. 

3. Double-click on the C:\temp\<OII70>\cd\disk1\install\setup.exe file. 
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The Welcome screen of the OII Installer opens. 

Figure 64: Installer Welcome Screen

4. Click Next. The Specify Home Details screen opens. When you first arrive at this screen 
the Name and Path fields are already populated with the default installation name and 
the full path.where OII will be installed.

Figure 65: The Default Settings on the Specify Home Details Screen
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5. Specify the installation name and the full default path where you want to install OII.

• Name: The Name field refers to the current Oracle home name for this particular 
installation of OII. Each Oracle home name has a unique name that distinguishes it 
from all other Oracle home names for other Oracle products on your machine. The 
Oracle home name is commonly used in Start menus items and to identify service 
names if the particular product is run as a Windows service.

• Path: This is the full path to the home directory where all OII files will be installed. 
It is strongly recommended that you enter a distinct path for the OII installation 
directory. For example: C:\Oracle\Insight_Home

Figure 66: Specify Home Details Screen

Note The Oracle home name and the OII home directory do not have to be the same.
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6. Click Next. The Select Installation Type screen opens. 

Figure 67: Select Installation Type Screen

7. Accept all of the selected components and click Next. The Specify OII OBIEE Config 
Parameters screen opens.

Figure 68: OII OBIEE Config Parameters Screen.
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8. Accept the default paths to the OBIEE Root directory and the OBIEE Data directory. 
These are the same paths that you specified when you initially installed OBIEE (see 
Chapter 5: Installing Oracle Business Intelligence Enterprise Edition on page 47). The 
default locations are:

• The default installation location is C:\OracleBI. 

• The default Data Location is C:\OracleBIData. 

9. Click Next. The Database Configuration Parameters screen opens. This screen allows 
you to enter the necessary parameters to connect to the Oracle database using SYSDBA 
privileges.

Figure 69: Database Configuration Parameters Screen

10. Specify the Oracle JDBC settings:

• Host Name - Enter the host name of the Oracle database.

• SID or Service Name - Enter either the System Identifier or Service Name of the 
Oracle database.

• Port - Enter the Port number.

11. Enter the following Database User Parameters to connect to the Oracle database:

• User Name - Enter the user name.

• Password - Enter the password.
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12. Select the Test Connection button to ensure that a connection to the Oracle database 
could be made with the information you provided. An error message will appear if the 
connection fails.

13. Click Next. The Schema Configuration Parameters screen opens. This screen allows 
you to enter user names and password for the OII schemas. Note that when you arrive at 
this screen a the default user names for the schemas (OII_ST, OII_WH, etc.) are already 
provided. These user names can be changed if you wish.

14. Keep the default user names or enter new ones for the OII schemas. 

15. Enter a password for each of the OII schemas.

Figure 70: Schema Configuration Parameters Screen

Important Make sure that you record the user names and passwords that you enter at this screen. 
You will need them later on in order to perform various configuration steps in ODI.
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16. Click Next. The Summary Screen opens.

Figure 71: Summary Screen



Chapter 7 – Installing Oracle Insurance Insight

66

17. Review the summary settings and click Install to start the installation. The following 
screen appears and allows you to follow the progress of the installation.

Figure 72: Progress Screen
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When the installation is complete the Configuration Assistant screen opens. This screen 
displays the tools to be run prior to completing the installation.

In the event that any components failed the configuration process, it will display the 
details of the error on the lower portion of the screen.

Figure 73: Configuration Assistants Screen

18. In the event of an error, refer to the log files and fix the issue and then select Retry. 

19. If all tools run successfully, you will automatically proceed to the next screen which will 
announce that the OII installation has been successful.

WHAT’S THE NEXT STEP IN THE INSTALLATION?
Once OII has been installed you will need to perform a series of post-installation steps, 
starting with creating and configuring a workspace for the OII Warehouse Palette in APEX. 
For these steps, go to:
• .Chapter 8: Performing the Oracle Application Express Post-Installation Steps



Chapter 7 – Installing Oracle Insurance Insight

68



69

Chapter 8

Performing the Oracle Application Express  
Post-Installation Steps

Once APEX is installed and running you must configure it to work with the Warehouse 

Palette. This process involves creating a Workspace for the Warehouse Palette via the Oracle 
Application Express Administration Service. 
This section will walk you through the steps for creating and configuring a workspace for the 
Warehouse Palette. For an in-depth description of the features of the APEX Administration 
Service, refer to these manuals: 

• Oracle Application Express Administration Guide Release 4.0

• Oracle Application Express Application Builder User’s Guide Release 4.0

Both of these manuals can be found along with the rest of the APEX documentation set at:
http://www.oracle.com/technetwork/developer-tools/apex/documentation/index.html
The following are the high-level steps for creating and configuring a Workspace for the 
Warehouse Palette.

Table 6: Configuration Road Map

Step Description

Step 1 Create a Workspace for the Warehouse Palette

Step 2 Create a User for the Warehouse Palette Workspace

Step 3 Delete the Sample Application from the Warehouse Palette Workspace

Step 4 Import OII Application into APEX

Step 5 Open the Warehouse Palette
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STEP 1: CREATE A WORKSPACE FOR THE WAREHOUSE PALETTE
1. Enter the URL for the APEX Administration Service in your Web browser: 

 
http://<hostname>:<port>/apex/apex_admin

where:

hostname - the host name where the WebLogic application server is installed.

port - is the port number assigned to the application server. The default port for the 
Oracle Application Express Listener deployed on WebLogic is 7001.

apex - the mount point defined in the Web Server configuration file.

For example:
http://host_name:7001/apex/apex_admin

The APEX Administration Service Login screen will appear in your browser:

Figure 74: APEX Administration Service Login Screen

2. When the Login page comes up for the APEX Administration Services enter:

• Username - Enter admin.

• Password: Enter the administrator account password that you specified when you 
changed the default administrator password.
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The APEX Administration Services console opens.

Figure 75: APEX Administration Services Console

3. Click on the Manage Workspaces tab. The Manage Workspaces page opens.

Figure 76: Manage Workspaces Page
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4. Click on Create Workspaces under the Workspace Actions section. The Identify 
Workspace screen opens. This is the first screen in a wizard that will walk you through 
the steps of creating a workspace.

Figure 77: Identify Workspace Screen

5. For Identify Workspace:

• Workspace Name - Enter a Workspace Name for the Warehouse Palette  
(i.e., OII_WP)

• Workspace ID - Leave this field blank. It will be automatically generated by APEX. 

• Workspace Description - Enter a description of the workspace. The description is 
optional.
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6. Click Next. The Identify Schema page opens.

Figure 78: Identify Schema Screen

7. For Identify Schema:

• Re-Use existing schema? - Select No.

• Schema Name - Enter a schema name for the Warehouse Palette (i.e. OII_WP).

• Schema Password - Enter a password for the schema.

• Space Quota - Accept the default.

8. Click Next. The Identify Administrator screen opens.

Figure 79: Identify Administrator Screen
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9. For Identify Administrator, enter a Username and Password of your choice for the 
Workspace. Note that the username/password that you enter here is different from the 
username/password that you used to log into the APEX Administration Services 
Console.

10. Click Next. The Confirm Request page opens.

Figure 80: Confirm Request Screen

Important Remember this username and password as well as the workspace name. You will need 
this information once you exit the APEX Administration Services Console and log back 
in.
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11. Review the information and click the Create Workspace button. The Success 
Confirmation page opens.

Figure 81: Success Confirmation Screen

12. Click Done. You will returned to the Manage Workspaces screen.

13. Click on the Logout link to exit the APEX Administrative Services console.
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14. Click on the Login button. This time you will be prompted for the Warehouse Palette 
workspace login information:

Figure 82: Login Screen for the Warehouse Palette Workspace

15. Enter the Workspace Name, Username, and Password for the Warehouse Palette 
workspace.

16. Click the Login button. This time a screen will appear and prompt you to change the 
workspace’s password:

Figure 83: Change Password for the Warehouse Palette

17. Change the Warehouse Palette workspace password:

• Enter the current password

• Enter a new password

• Reenter the new password

• Click Apply Changes.
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A message will appear on the screen confirming that the password has changed. A single 
Return button will also appear on the screen.

18. Click the Return button. You will be returned to the Login screen.

Figure 84: Login Screen for the Warehouse Palette Workspace
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19. Enter the new password and click the Login button. The screen will open on the 
Warehouse Palette workspace.

Figure 85: The Warehouse Palette Workspace
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STEP 2: CREATE A USER FOR THE WAREHOUSE PALETTE 
WORKSPACE

1. Open the Administration menu and select Manage Users and Groups. The Users 
screen for the Warehouse Palette workspace opens.

Figure 86: Users Screen for the Warehouse Palette Workspace

2. Click the Create User button. The Create User page opens.

Figure 87: Create User Page



Chapter 8 – Performing the Oracle Application Express Post-Installation Steps

80

3. Under User Identification, enter:

• Username - Enter the username that is used to log into the system.

• Email Address - Enter an email address for the user.

• First Name (optional) - Enter the user’s first name.

• Last Name (optional) - Enter the user’s last name.

• Description (optional) - Enter a description of the user (i.e, business analyst).

4. Under Account Privileges:

• Default Schema - The default schema is the schema you created for the workspace 
(see page 73). 

• Accessible Schemas (null for all) - Leave this field blank.

• User is a workspace administrator - Select No.

• User is a developer - Select No.

• Application Builder Access - Determines whether a developer has access to the 
Application Builder. This option is greyed out if “No” is selected at User is a 
developer.

• SQL Workshop Access - Determines whether a developer has access to the SQL 
Workshop. This option is greyed out if “No” is selected at User is a developer.

• Team Development Access - Determines whether a developer has access to the 
Team Development.

• Set Account Availability - Select Locked to prevent the account from being used 
or Unlocked to allow the account to be used. 

5. Under Password:

• Password - Enter a password for the user.

• Confirm Password - Reenter the user password.

• Require Change of Password on First Use - Select No to allow the user to use the 
password until it expires. Select Yes to require the user to change the password upon 
the initial login.

6. Click the Create User button. You will be returned to the Users screen. The new user is 
listed on the screen.

Figure 88: The New User is Added to the Warehouse Palette Workspace
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STEP 3: DELETE THE SAMPLE APPLICATION FROM THE 
WAREHOUSE PALETTE WORKSPACE

APEX adds a sample application to each new workspace that is created. The sample 
application serves no purpose in the Warehouse Palette workspace and should be removed.

1. Log into APEX as an administrator.

2. Return to the Homes page for the Warehouse Palette workspace.

3. Select the Application Builder icon. The Application Builder page open. 

Figure 89: Sample Application

4. Click on the Sample Application. The page for the Sample Application opens.

Figure 90: Contents of the Sample Application
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5. Click on the Edit Application Properties. The Edit Application screen opens.

Figure 91: Sample Application Definitions.

6. Click on the Delete button. A message screen will appear asking you to confirm your 
decision.

Figure 92: Confirm Deletion of Sample Application

7. Click the Permanently Delete Now button.

8. You will be returned to the All Applications tab on the Application Builder screen. A 
message at the top of the screen will inform you that the Sample Application has been 
deleted.
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STEP 4: IMPORT OII APPLICATION INTO APEX
During the installation of OII, the OII Installer copies a SQL script, wp_apex.sql, to your 
system that must be imported into APEX. This file is located under:
<OII_ROOT>\install\apex
where:

• <OII_ROOT> - is the OII installation directory. For example:

C:\Oracle\Insight_Home\Insurance\oii\7.0.0\install\apex

1. On the Application Builder page, click on the Import button. The Specify File page 
opens:

2. For the Specify File box, select the following:

• Import File - Use the Browse button to locate: 
 
<OII_ROOT>\install\apex\wp_apex.sql. 

• File Type - Select Database Application, Page or Component Export.

• File Character Set - Verify that the File Character Set is correct.

3. Click Next. The screen refreshes and message will inform you that the import was 
successful.

Figure 93: File Import Confirmed

4. Click Next. The Install Application page opens.

Figure 94: Install Application
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5. In Install Application, select the following:

• Parsing Schema - Select the OII_WP schema that you created previously.

• Build Status - Select either:

• Run Application Only

• Run and Build Application

• Install as Application - Select either:

• Auto Assign New Application ID

• Reuse Application ID From Export File

• Change Application ID.

6. Click Install. You will be returned to the Application Builder page. The newly installed 
application will appear on this page.

STEP 5: OPEN THE WAREHOUSE PALETTE
1. Open you browser and enter the URL where the Warehouse Palette resides: 

 
http://<hostname>:<port>/apex/

where:

hostname - the name of the system where WebLogic is installed.

port - is the port number assigned to the WebLogic application server. The default port 
is 7001.

apex - the mount point defined in the Web Server configuration file.

The Warehouse Palette login screen appears:

Figure 95: Warehouse Palette Login Screen

2. Type in the Username and Password for the Workspace that you created in Step 1: Create 
a Workspace for the Warehouse Palette on page 70.

3. Click the Login button. 
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4. The Manage LOBs page opens. This screen is the home page of the Warehouse Palette.

Figure 96: Warehouse Palette Home Page

5. Click on Options to open the Options page.

Figure 97: Options Page

6. At the Web Service Host field enter the hostname and port in this format:

<hostname>:port

where:

• <hostname> - the name of the system where WebLogic is installed.

• port - is the port number assigned to the WebLogic application server. The default 
port is 7001.

7. Click Apply Changes to save your change.

8. Select Logout to exit the Warehouse Palette.

Note The Options screen can only be modified by a user with Administrator privileges. For all 
other users, this screen is read-only.
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WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step in the installation process is to perform a series of configuration tasks to 
provide security credentials for the ODI Wrapper Service. For these tasks, go to:

• Chapter 9: Setting Up Security Credentials for the ODI Wrapper Service
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Chapter 9

Setting Up Security Credentials for the ODI 
Wrapper Service
This chapter describes how to setup the security credentials for the ODI Wrapper Service. 
There are different instructions for configuring the security credentials in Windows and HP-
UX environments. This chapter provides the instructions for users working in a Windows 
environment. For the instructions for setting up security credentials for the ODI Wrapper 
Service in an HP-UX environment refer to Appendix A: HP-UX Instructions.

STEP 1: EDIT THE CSUTIL.PROPERTIES FILE
1. Go to the <OII_ROOT>\app\csutil\config\ directory and locate the csutil.properties 

file.

For example: 
 
C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app\csutil\config\csutil.properties

2. Open csutil.properties in a text editor. This file contains a single line showing the full 
path to the jps-config-jse.xml file. For example:

CredentialStoreConfig=C:\\Oracle\\Middleware\\user_projects\\dom
ains\\<domain_name>\\config\\fmwconfig\\jps-config-jse.xml

Note Throughout this chapter we will be referring to the directory structure created during the 
OII installation. For the sake of consistency this section will refer to the default OII 
installation directory as <OII_Root>. For example:
C:\Oracle\Insight_Home\Insurance\oii\7.0.0

Note The example above shows the default name and location of the Middleware home 
directory (i.e., C:\Oracle\Middleware) and the Domain home directory (i.e., 
C:\Oracle\Middleware\user_projects\domains) as they appear in the 
csutil.properties file. These are the default locations that were created when you 
installed JDeveloper and WebLogic and created the WebLogic domain back in Chapter 
3: Installing Oracle WebLogic Server and Oracle JDeveloper. 
If you specified different locations for Middleware and Domain home directories, please 
use those directories instead of the default ones presented in the csutil.propertiesfile.
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3. Replace <domain_name> in this line with the actual name of the domain that you 
created in Chapter 3: Installing Oracle WebLogic Server and Oracle JDeveloper (see 
Step 3: Create a WebLogic Domain on page 24).

For example:

CredentialStoreConfig=C:\\Oracle\\Middleware\\user_projects\\dom
ains\\oii_domain\\config\\fmwconfig\\jps-config-jse.xml

4. Save and close the csutil properties file.

STEP 2: ADD SECURITY CREDENTIALS
Once you have updated csutil.properties you will need to run the add.bat command three 
times at the command line in order to add the security credentials for each of the following 
key names:
• ODIUSER
• DBAUSER
• WPUSER

When you run add.bat you will be prompted for a key name, user name and password. The 
required user name and password combinations for each ley name are shown in the table 
below.

Note In windows you must keep the double forward backslashes (\\).

key name user name password

ODIUSER SUPERVISOR SUNOPSIS

DBAUSER OII_SYS The corresponding password you entered for OII_SYS on 
the Schema Configuration Parameters screen during the 
OII installation (see Chapter 7: Installing Oracle Insurance 
Insight on page 64).

WPUSER OII_WP The corresponding password you entered for OII_WP on 
the Schema Configuration Parameters screen during the 
OII installation (see Chapter 7: Installing Oracle Insurance 
Insight on page 64).

Note You may have entered different user names during the OII installation but the user names in 
the table above are based on the assumption that you accepted the user name defaults on 
the Schema Configuration Parameters screen during the OII installation. 
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To add the security credentials:

1. Open a command prompt and go to: <OII_Root>app\csutil\bin 

For example:  
 
C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app\csutil\bin 

2. At the command line, type add and press Enter. You will be prompted for a key name: 

3. For ODIUSER, type in the key name, user name, and password from the table above 
while pressing Enter after each entry. A message will confirm that the security 
credential for ODIUSER has been added. For example: 

4. For DBUSER, run the add command again and enter the information from the table on 
the previous page for DBAUSER when prompted. For example: 

5. For WPUSER, run the add command a third time and enter the information from the 
table on the previous page for WPUSER when prompted. For example: 

>Enter key: 

>Enter key: ODIUSER
>Enter username: SUPERVISOR
>Enter password: 
>Credential added: ODIUSER

>Enter key: DBAUSER
>Enter username: OII_SYS
>Enter password: 
>Credential added: DBAUSER

>Enter key: WPUSER
>Enter username: OII_WP
>Enter password: 
>Credential added: WPUSER

Note The <OII_Root>app\csutil\bin directory also contains a readme.txt file which lists a 
series of batch file commands for adding, deleting, updating, and testing security 
credentials. You can refer to them as needed. For example, if you come across an 
existing key, you can run the update command describe in the readme file to update the 
credential.
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WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step in the installation process is to setup the security credentials for the Warehouse 
Palette agent. For these tasks, go to:
• .Chapter 10: Setting Up Security Credentials for the Warehouse Palette Agent
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Chapter 10

Setting Up Security Credentials for the 
Warehouse Palette Agent 
This chapter describes how to edit the properties file that manage the security credentials for 
the Warehouse Palette agent. 
There are different instructions for configuring the security credentials in Windows and HP-
UX environments. This chapter provides the instructions for users working in a Windows 
environment. For the instructions for setting up security credentials for the Warehouse Palette 
Agent in an HP-UX environment, refer to Appendix A: HP-UX Instructions.

STEP 1: EDIT THE AGENT.PROPERTIES FILE
1. Go to the <OII_ROOT>\app\agent\config\ directory and locate the agent.properties 

file.

For example: 
 
C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app\agent\config\agent.properties 

2. Open agent.properties in a text editor. This file contains these lines: 

CredentialStoreConfig=C:\\Oracle\\Middleware\\user_projects\\dom
ains\\<domain_name>\\config\\fmwconfig\\jps-config-jse.xml

JdbcUrl=jdbc:oracle:thin:@<host>:<port>:<sid>

Note For instructions on scheduling the Warehouse Palette Agent to run as a Windows 
Service, refer to Appendix B: Scheduling the Warehouse Palette Agent as a Windows 
Service.

Note Throughout this chapter we will be referring to the directory structure created during the 
OII installation. For the sake of consistency this section will refer to the default OII 
installation directory as <OII_Root>. For example:
C:\Oracle\Insight_Home\Insurance\oii\7.0.0
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3. In the first line, replace <domain_name> with the name of the WebLogic domain you 
created when you initially installed WebLogic. 

For example:

CredentialStoreConfig=C:\\Oracle\\Middleware\\user_projects\\dom
ains\\oii_domain\\config\\fmwconfig\\jps-config-jse.xml

4. On the next line, enter the applicable <host>, <port>, and <sid> for the Oracle database.

JdbcUrl=jdbc:oracle:thin:@<host>:<port>:<sid>

5. Save and close agent.properties.

STEP 2: TEST THE WAREHOUSE PALETTE AGENT
1. Open a command prompt and go to: <OII_ROOT>\app\agent\bin

For example: C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app\agent\bin

2. At the command prompt type: agent_status

This command will show the status of all LOBs in the Warehouse Palette. If there is a 
connection problem a message will appear identifying the problem.

STEP 3: START AND STOP THE WAREHOUSE PALETTE AGENT
1. Open a command prompt and go to: <OII_ROOT>\app\agent\bin

For example: C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app\agent\bin

2. Start the agent by typing: agent_start

3. Open a new window and type the following to stop agent: agent_stop

WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step in the installation process is to perform a series of configuration tasks in ODI. 
For these tasks, go to: 
• Chapter 11: Performing the ODI Post-Installation Steps

Note The example above shows the default name and location of the Middleware home 
directory (i.e., C:\Oracle\Middleware) and the Domain home directory (i.e., 
C:\Oracle\Middleware\user_projects\domains) as they appear in the 
agent.properties file. These are the default locations that were created when you 
installed JDeveloper and WebLogic and created the WebLogic domain back in Chapter 
3: Installing Oracle WebLogic Server and Oracle JDeveloper. 
If you specified different locations for Middleware and Domain home directories, please 
use those directories instead of the default ones presented in the agent.properties file.

Note On windows you must keep the double-forward backslashes (\\).
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Chapter 11

Performing the ODI Post-Installation Steps
The OII installer downloaded a Master and Work Repository to your system that must be 
imported into ODI for use with OII. This section provides the steps to create, configure, and 
import these repositories.
The basic steps for creating and configuring the repositories are described below:

STEP 1: CREATE MASTER AND WORK REPOSITORY SCHEMAS
1. At the command line, start SQL*Plus and connect to the database as SYS, specifying the 

SYSDBA role. Use the net service name (e.g. Insight700) you created in Chapter 2: 
Installing Oracle Database Client to connect to the Oracle database (see Step 3: Create 
a Client Connection on page 8). For example:

 
Information similar to the following output is displayed on the screen: 

Table 7: Configuration Road Map

Step Description

Step 1 Create the Schemas for the Master and Work Repositories

Step 2 Import the Database Dump Files

Step 3 Connect to the Master Repository

Step 4 Update the Connection Information to the Master and Work Repositories

> sqlplus sys@Insight700 as sysdba 

> SQL*Plus: Release 11.2.0.1.0 Production on Fri Jan 14 15:29:19 2011

> Copyright (c) 1982, 2010, Oracle.  All rights reserved.

> Enter password: 
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2. Enter the appropriate password to connect to the database. The SQL> prompt will appear 
on the command line: 

3. At the command line, run the following SQL commands to create a schema for the 
Master Repository and grant connect privileges for the newly created user:

Where:

• <MY_SCHEMA> - is the name of the schema for the Master Repository.

• <MY_PASS> - is the corresponding password for the user.

• <MY_TBS> - is the name of the Oracle tablespace where the data is stored.

• <MY_TEMP> - is the temporary default tablespace.

For example: 

4. Create a schema for the Work Repository using the syntax from the commands in step 3.

For example:

SQL>

SQL>create user <MY_SCHEMA> identified by <MY_PASS>

 default tablespace <MY_TBS> temporary tablespace <MY_TEMP>;

SQL>grant connect, resource, unlimited tablespace to <MY_SCHEMA>; 

SQL>create user ODI_MASTER identified by oracle1

 default tablespace USERS temporary tablespace TEMP;

SQL>grant connect, resource, unlimited tablespace to ODI_MASTER; 

SQL>create user ODI_WORK identified by oracle1

 default tablespace USERS temporary tablespace TEMP;

SQL>grant connect, resource, unlimited tablespace to ODI_WORK; 
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STEP 2: IMPORT THE DATABASE DUMP FILES
During the OII installation, the OII installer copies two database dumps to your system. 
These contain the OII Master and Work repositories and must be manually imported into the 
Master and Work schemas that you created in the previous section These database dumps are 
located under: <OII_Root>\install\odi
Where:

• <OII_Root> - is the default location of the OII installation directory  
(i.e., C:\Oracle\Insight_Home\Insurance\oii\7.0.0\install).

• \install\odi - is the location of the directory containing the ODI dump files for the Master 
and Work repositories. This directory contains two subdirectories: master_repo and 
work_repo.

The names of these files are

• OII_ODI_MS.dmp - the Master dump file.

• OII_ODI_WK.dmp - the Work dump file.

Step A:Import the Master Database Dump File
1. At the command prompt, navigate to: 

<OII_Root>\install\odi\master_repo

For example:

C:\Oracle\Insight_Home\Insurance\oii\7.0.0\install\odi\master_repo

2. Use the imp command to import the Master Repository:

For example:

imp ODI_MASTER/<password>@<Net Service Name> FROMUSER=OII_ODI_MS 
TOUSER=ODI_MASTER FILE=OII_ODI_MS.dmp

Note Use the Net Service Name in the imp command to connect to the database if ODI is not 
running on the database server. The example below uses the sample Net Service Name 
(Insight700) that was defined in Chapter 2: Installing Oracle Database Client. (Step 3: 
Create a Client Connection on page 8). 

imp ODI_MASTER/oracle1@Insight700 FROMUSER=OII_ODI_MS 
TOUSER=ODI_MASTER FILE=OII_ODI_MS.dmp
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Step B:Import the Work Database Dump File
1. At the command prompt, navigate to: 

<OII_Root>\install\odi\work_repo

For example:

C:\Oracle\Insight_Home\Insurance\oii\7.0.0\install\odi\work_repo

2. Type the following command to import the Work Repository:

For example:

Note Include the Net Service Name in the imp command for the Work Repository just as you 
did for the Master Repository. 

imp ODI_WORK/<password>@<Net Service Name> FROMUSER=OII_ODI_WK  
TOUSER=ODI_WORK FILE=OII_ODI_WK.dmp

imp ODI_WORK/oracle1@Insight700 FROMUSER=OII_ODI_WK  
TOUSER=ODI_WORK FILE=OII_ODI_WK.dmp
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STEP 3: CONNECT TO THE MASTER REPOSITORY
In this step you must use ODI Studio to connect to the Master and Work Repositories that 
you imported in the previous section.

1. Open ODI Studio:

Start>All Programs>Oracle>Oracle Data Integrator>ODI Studio

2. When run for the first time, ODI Studio prompts you for the location of Java JDK. Enter 
the path of the Java JDK under the Middleware Home directory as shown below:

Figure 98: Enter the Path of the Java JDK

3. ODI Studio will open:

Figure 99: ODI Studio
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4. Select File > New to open the New Gallery screen.

Figure 100: New Gallery Screen

5. In the Categories tree on the left, select ODI and then select Create a New ODI 
Repository Login from the Items list.
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6. Click OK. The Repository Connection Information screen appears. 

Figure 101: Repository Connection Information Screen

7. Specify the Oracle Data Integrator Connection details: 

• Login name: A name used to connect to the Master Repository and then to create 
the Work Repository. It can be any name that you choose (this examples uses 
ODI_MASTER as the login name).

• User: SUPERVISOR

• Password: SUNOPSIS

Note Use upper case for the User and Password just as they appear above.
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8. Specify the Database Connection (Master Repository) details: 

• User: The same user name (e.g. ODI_MASTER) that you specified when you 
created the schema for the Master Repository in Step 1: Create Master and Work 
Repository Schemas on page 93. 

• Password: The same password (e.g. oracle1) that you specified when you created 
the schema for the Master Repository in Step 1: Create Master and Work Repository 
Schemas on page 93. 

• Driver List: Select “Oracle JDBC Driver”. 

• Driver Name: This field will be automatically filled out based upon the Driver List. 
In this case the driver name is “oracle.jdbc.OracleDriver”.

• URL: The URL used to establish the JDBC connection to the database hosting the 
repository: (i.e. jdbc:oracle:thin:@<host>:<port>:<sid> ).

9. Under Work Repository select the Work Repository radio button.

10. Click on the Search button on the right. The Select Repository window will appear. 

11. Select “DEV”. This is the name of the Work Repository from the database dump file that 
you imported into ODI in Step 2: Import the Database Dump Files on page 95.
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12. Click OK. “DEV” will appear in the Work Repository field back on the Repository 
Connection Information window.

Figure 102: Connection Information for the Master Repository

13. Click Test to validate your entries. A message box will appear and report:

Figure 103: Connection to the Master Repository was Successful

14. Click OK to close this message box.

15. On the Repository Connection Information window, click OK to close the window.



Chapter 11 – Performing the ODI Post-Installation Steps

102

16. Select ODI>Connect. The Oracle Data Integrator Login window will open.

Figure 104: Oracle Data Integrator Login Window

17. Select the Login Name to the Master Repository that you created in the previous step 
(e.g. ODI_MASTER) from the drop-down list and click OK. A series of messages will 
appear on the screen as you are connected to the Master Repository.

18. Once connected, open the Topology Navigator by selecting View>ODI Topology 
Navigator.

Figure 105: ODI Topology Navigator
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19. Click on the Repositories panel to display the Master and Work Repository. 

Figure 106: Master and Work Repository

20. Click on the Work Repositories node to confirm that the “DEV” Work Repository is 
present. 

Figure 107: “DEV” Work Repository



Chapter 11 – Performing the ODI Post-Installation Steps

104

STEP 4: UPDATE THE CONNECTION INFORMATION TO THE 
REPOSITORIES

After you import the ODI master and work repository, you will need to update the 
connection information stored there to point to you own environment.
1. In the Topology Navigator (View>ODI Topology Navigator) click on the Physical 

Architecture panel.

Figure 108: Physical Architecture Panel

2. Expand the Technologies node and scroll down to the Oracle node.
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3. Expand the Oracle node to display the ORACLE_OII node.

Figure 109: ORACLE_OII

4. Double-click on ORACLE_OII. The Data Server dialog box for ORACLE_OII will 
appear on the right.

Figure 110: Data Server for ORACLE_OII

5. Update the user name and password with your OII_SYS user name and password. This 
is the same user name and password that you entered on the Schema Configuration 
Parameters screen (see Chapter 7: Installing Oracle Insurance Insight on page 64) 
during the OII installation.
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6. Click on the JDBC item to open the JDBC screen.

Figure 111: JDBC Screen for ORACLE_OII

7. Update the information on the JDBC screen.

8. Click on the Test Connection button at the top of the JDBC screen to test the updated 
connection information. The following dialog box opens:

Figure 112: Test Connection Dialog Box

9. Click the Test button. The following dialog box should appear to indicate that the 
connection was successful. If you receive an error message, return to the Data Server and 
JDBC screen and confirm that the connection information you entered was correct.

Figure 113: Connection to the Master Repository was Successful



Step 4: Update the Connection Information to the Repositories

107

10. Expand the ORACLE_OII node. You will see all physical schemas attached to this data 
server. There are four listed there: OII_DM, OII_WH, OII_ST and OII_SYS. 

Figure 114: Schemas for Oracle_OII

11. Separately double-click on each schema to open the Physical Schema screen.

Figure 115: Physical Schema for OII_DM

12. Confirm that each schema has the Work Schema set to OII_WRK.

Figure 116: Work Schemas Must be Set to OII_WRK

13. Once you have reviewed the information for all of the schemas, select Save from the File 
menu or tool bar to save any changes.
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WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step in the installation process is to perform a series of configuration tasks for 
OBIEE. For these steps, go to:

• Chapter 12: Performing OBIEE Post-Installation Steps
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Chapter 12

Performing OBIEE Post-Installation Steps
For the sake of consistency the following naming conventions will be used throughout this 
section:

• <OBIEE_Root> - This is the default OBIEE root folder (i.e. C:\OracleBI).

• <OBIEE_Data> - This is the default OBIEE Data folder (i.e. C:\OracleBIData).

• <OII_Root> - This is the OII root folder  
 
(i.e. C:\Oracle\Insight_Home\Insurance\oii\7.0.0\).

Table 8: Configuration Road Map

Step Description

Step 1 Configure the OBIEE Repository and Web Catalog

Step 2 Setup Two Oracle ODBC Data Source Connections

Step 3 Update the OBIEE Repository

Step 4 Update the analytics.war File

Step 5 Deploy analytics.war on WebLogic

Step 6 Access OBIEE
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STEP 1: CONFIGURE THE OBIEE REPOSITORY AND WEB CATALOG

Step A: Copy the OII Repository File into OBIEE
1. Locate the OII repository file, Insight_700.rpd, under:

<OII_Root>\install\obiee\repo

For example:

C:\Oracle\Insight_Home\Insurance\oii\7.0.0\install\obiee\repo

Figure 117: <OII_Root>\install\obiee\repo

2. Copy Insight_700.rpd, to the following directory:

<OBIEE_Root>\server\Repository

For example:

C:\OracleBI\server\Repository



Step 1: Configure the OBIEE Repository and Web Catalog

111

Figure 118: <OBIEE_Root>\server\Repository Directory

Step B: Edit the NQSConfig.INI File
1. Locate the NQSConfig.INI file under:  

 
<OBIEE_Root>\server\Config

For example:

C:\OracleBI\server\Config

Figure 119: <OBIEE_Root>\server\Config\NQSConfig.INI
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2. Open NQSConfig.INI in a text editor.

3. Scroll down to the “Repository Section” and locate a line similar to this one (the actual 
.RPD file name in this line will be vary from computer to computer):

Figure 120: Repository Parameter in NQSConfig.INI File

4. Replace this line with the following line:

Star = Insight_700.rpd, DEFAULT;

5. Scroll down to the “Query Result Cache Section” and make sure that the following 
parameter is set to: 

ENABLE=YES;

Figure 121: Set Cache to “YES”

6. Save and close the NQSConfig.INI file.
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Step C: Copy the Insight_7 Folder
1. Locate the Insight_7 directory:

<OII_Root>\install\obiee\catalog\Insight_7

For Example:

C:\Oracle\Insight_Home\Insurance\oii\7.00\install\obiee\catalog\Insight_7

Figure 122: <OII_Root>\install\obiee\catalog\Insight_7

2. Copy the Insight_7 folder to the following directory: 
 
<OBIEE_Data>\web\catalog

For example:

C:\OracleBIData\web\catalog

Figure 123: <OBIEE_Data>\web\catalog
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Step D: Edit the instanceconfig.xml File
1. Locate and the instanceconfig.xml file under this directory:

<OBIEE_Data>\web\config

For example:

C:\OracleBIData\web\config

2. Open the instanceconfig.xml file in a text editor.

3. Look through the file for the line beginning with the <CatalogPath> tag. It should be 
near the top of the file:

Figure 124: The instanceconfig.xml File

4. Between the <CatalogPath> and </CatalogPath> tags, enter the full path to: 
 
<OBIEE_Data>\web\catalog\Insight_7 
 
For example: 
 
<CatalogPath>C:\OracleBIData\web\catalog\Insight_7</CatalogPath>
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5. Insert the following text at the end of the instanceconfig.xml file just before the  
</ServerInstance> tag:

For example:

Figure 125: instanceconfig.xml File with New Content

6. Save and close the instanceconfig.xml file.

<DashboardMaxBeforeMenu>2</DashboardMaxBeforeMenu>
<Dashboard>
    <EnableBookmarkURL>True</EnableBookmarkURL>
    <EnablePromptedURL>True</EnablePromptedURL>
    <BookmarkExpirationDays>30</BookmarkExpirationDays>
</Dashboard>
<SubjectAreaMetadata>
   <DictionaryURLPrefix>/analytics/dictionary/</DictionaryURLPrefix>
</SubjectAreaMetadata>
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Step E: Stop and Restart the BI Server
Stop and restart the Oracle BI Server and the Oracle BI Presentation Server to apply the 
changes in the previous steps:

1. From the Start menu select Control Panel>Administrative Tools>Services to open the 
Services window.

2. Locate the Oracle BI Server and the Oracle BI Presentation Server in the list of services.

Figure 126: Locate Oracle BI Presentation Server and Oracle BI Server

3. Separately highlight the name of the server in the list and click the Stop link.

4. Separately highlight the name of the server in the list and click the Restart link.
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STEP 2: CREATE THE ORACLE ODBC DATA SOURCE CONNECTIONS
In this step you must create two separate Oracle ODBC data source connections named 
Insight700 and Insight700Config. 

Step A: Create the Insight700 Data Source
1. Select All Programs>Oracle – OraClient11g_home>Configuration and Migration 

Tools>Microsoft ODBC Administrator. The ODBC Data Source Administrator win-
dow will display.

Figure 127: ODBC Data Source Administrator Screen



Chapter 12 – Performing OBIEE Post-Installation Steps

118

2. Click on the “System DSN” tab. The following screen opens:

Figure 128: System DSN Tab

3. Click on the Add button. The Create New Data Source screen appears.

Figure 129: Select “Oracle in OraClient11g_home1”
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4. Scroll down the list of drivers and select Oracle in OraClien11g_home1.

5. Click on Finish. The Oracle ODBC Driver Configuration window opens. 

Figure 130: Driver Configuration Screen

6. Enter the following information in this window:

• Data Source Name: Enter Insight700 as the Data Source Name.

• Description: Enter an optional description.

• TNS Service Name: Select the Net Service Name from the drop-down list that you 
created in Creating a Net Service Name in Oracle Client on page 9 in Chapter 3: 
Performing Pre-Installation Tasks. In the example in that chapter the name of the 
Net Service Name was “Insight700”.

• User ID: Enter OII_DM as the user name.  
 
OII_DM is the default user name for the Data Mart Schema from the Schema 
Configuration Parameters Screen (see page 28 in Chapter 7: Installing Oracle 
Insurance Insight) that appeared when you installed OII. If you entered a different 
name for the Data Mart Schema at that screen then use that name instead.
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Figure 131: Driver Configuration Screen Entries

7. Click on the Test Connection button. The Oracle ODBC Driver Connect window will 
display. 

Figure 132: Driver Connect Window

8. Type in the corresponding password that you entered for OII_DM on the Schema 
Configuration Parameters Screen (see page 28 in Chapter 7: Installing Oracle Insurance 
Insight).

9. Click on OK. A “Connection successful” message box will display. 

10. Click on OK to close this message box.

11. Click on OK in the Oracle ODBC Driver Configuration window. 
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12. The new data source is listed in the System DSN tab of the ODBC Data Source 
Administrator window.

Figure 133: Insight700 Data Source



Chapter 12 – Performing OBIEE Post-Installation Steps

122

Step B: Create the Insight700Config Data Source
1. From the “System DSN” tab click on the Add button. The Create New Data Source 

screen opens.

Figure 134: Select “Oracle in OraClient11g_home1”

2. Scroll down the list of drivers and select Oracle in OraClien11g_home1

3. Click on Finish. The Oracle ODBC Driver Configuration window opens. 

Figure 135: Driver Configuration Screen
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4. Enter the following information in this window:

• Data Source Name: Enter Insight700Config as the Data Source Name.

• Description: Enter an optional description.

• TNS Service Name: Select the Net Service Name from the drop-down list that you 
created in Creating a Net Service Name in Oracle Client on page 9 in Chapter 3: 
Performing Pre-Installation Tasks. In the example in that chapter the name of the 
Net Service Name was “Insight700”.

• User ID: Enter OII_SYS as the user name.  
 
OII_SYS is the default user name for the System Configuration Schema from the 
Schema Configuration Parameters Screen (see page 28 in Chapter 7: Installing 
Oracle Insurance Insight) that appeared when you installed OII. If you entered a 
different name for the System Configuration Schema at that screen then use that 
name instead.

Figure 136: Driver Configuration Screen Entries



Chapter 12 – Performing OBIEE Post-Installation Steps

124

5. Click on the Test Connection button. The Oracle ODBC Driver Connect window will 
display. 

Figure 137: Driver Connect Window

6. Type in the corresponding password that you entered for OII_SYS on the Schema 
Configuration Parameters Screen (see page 28 in Chapter 7: Installing Oracle Insurance 
Insight).

7. Click on OK. A “Connection successful” message box will display. 

8. Click on OK to close this message box.

9. Click on OK in the Oracle ODBC Driver Configuration window. 

10. The new data source is listed in the System DSN tab of the ODBC Data Source 
Administrator window.

Figure 138: Insight700Config Data Source
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STEP 3: UPDATE THE OBIEE REPOSITORY
This step requires you to update the OBIEE repository information for the OII Subject Areas.

Step A: Open the OBIEE Repository
1. Open the OBIEE Repository Administration Tool by selecting:

Start>All Programs>Oracle Business Intelligence>Administration

Figure 139: Open OBIEE Administration Tool

2. When the Administration Tool opens, select File>Open>Online or click the Open 
Online button.

Figure 140: Open Online Button
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3. In the login dialog box that appears, enter the password (the default password is 
Administrator) and click on the Open button.

Figure 141: Enter the Administration Tool Password

The following Repository screen will open:

Figure 142: Layers of the OBIEE Repository for OII
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Step B: Configure the Line of Business Subject Areas
1. Go to the Physical Layer pane. This pane contains the Subject Areas for each Line of 

Business (Commercial Auto, Homeowners, etc.) and an additional Subject Area called 
Insight700Config. You will need to configure the settings under each of the Line of 
Business Subject Areas and the Insight700Config Subject Area.

2. Expand each of the Line of Business Subject Areas under the Physical Layer pane. The 
Connection Pool icon will appear underneath each Subject Area:

Figure 143: Subject Areas under the Physical Layer

Important The following configuration steps apply only to the Subject Areas for each Line of 
Business. The steps to configure the Insight700Config Subject Area are described in 
the next section on page129.
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3. Starting with the Commercial Auto Subject Area, click on the Connection Pool icon.

Figure 144: Connection Pool Icon

4. A message box will appear and ask you if you want to check out the Connection Pool.

5. Select Yes. The Connection Pool screen opens:

Figure 145: The Connection Pool Screen

6. Make sure that the Require fully qualified table names option is unchecked. 

7. Under the “Shared Login” section, update the user name and password with the same 
ones that you entered for the Insight700 data source that you created in Step A: Create 
the Insight700 Data Source on page 117.

8. Leave all of the other settings as is and click OK to close the screen.
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9. Repeat the steps 1-7 for each of the remaining Line of Business Subject Areas:

• Commercial Property

• Corporate

• Dwelling Fire

• Homeowners

• Personal Auto

• Personal Umbrella

Step C: Configure the Insight700Config Subject Area
1. Click on the Connection Pool under the Insight700Config Subject Area to open the 

Connection Pool window. 

Figure 146: Insight700Config Connection Pool Window
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2. Make sure the data source name is Insight700Config.

3. Make sure that the Require fully qualified table names option is unchecked. 

4. Under the Shared Login section, update the user name and password with the same ones 
that you entered for the Insight700Config data source that you created in Step B: Create 
the Insight700Config Data Source on page 122.

5. Click OK to close the screen.

Step D: Check in the Changes to the Physical Layer
1. Check in all the changes by click on “Check-in” button at the top tool bar:

Figure 147: Check in Changes

2. Click the Save button.

3. Click the Close and Exit buttons to exit the OBIEE Administration Tool.

Step E: Stop and Restart the Oracle BI Server and Oracle BI Presentation Server
1. From the Start menu select Control Panel>Administrative Tools>Services to open the 

Services window.

2. Locate the Oracle BI Server and the Oracle BI Presentation Server in the list of services.

Figure 148: Locate Oracle BI Presentation Server and Oracle BI Server
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3. Separately highlight the name of the server in the list and click the Stop link.

4. Separately highlight the name of the server in the list and click the Restart link.

STEP 4: UPDATE THE ANALYTICS.WAR FILE
1. Locate the OBIEE analytics.war file. Normally this file is located under: 

<OBIEE_Root>\web

For example:

C:\OracleBI\web

Figure 149: <OBIEE_Root>\Web\analytics.war

2. Copy analytics.war to a temporary location on your computer.
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3. Use 7-Zip to open the analytics.war file (right-click on analytics.war and from the pop-
up menu select 7-Zip>Open Archive).

Figure 150: Open the Analytics.war File

The contents of the analytics.war file will be similar to the figure below:

Figure 151: Contents of analytics.war
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4. Within this file create a folder called dictionary:

a. Select File>Create Folder (or press F7).

Figure 152: Create a New Folder Called “dictionary”

b. In the Create Folder box that appears, enter “dictionary” as the folder name and 
press OK.

Figure 153: Create Folder Dialog Box
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c. The dictionary folder will appear in the analytics.war file.

Figure 154: The “dictionary” Folder has been Created in the analytics.war File

5. Leave the 7-Zip window open and go to the folder:

<OII_Root>\install\obiee\metadata_dic\Insight_700
For example:
C:\Oracle\Insight_Home\Insurance\oii\7.0.0\install\obiee\metadata_dic\Insight_700\

Figure 155: <OII_Root>\install\obiee\metadata_dic\Insight_700
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6. Copy the entire Insight_700 folder into the dictionary folder in the 7-Zip window. 

7. Save analytics.war and close the 7-Zip window.

STEP 5: DEPLOY OBIEE ANALYTICS.WAR ON WEBLOGIC
1. If it is not already started, start the WebLogic server from the Start Menu:

Start Menu>Oracle Fusion Middleware>User Projects<Your Server 
Domain>Start Admin Server for WebLogic Server Domain

A separate window will open and display a series of messages to indicate that the domain 
server is up and running.

2. Once the WebLogic server domain is running, select: 
 
Start Menu>All Programs>Oracle WebLogic>User Projects><Your Server 
Domain>>Admin Server Console

The WebLogic Server Administration Console login screen will open:

Figure 156: WebLogic Server Administration Console Login Screen

Note <Your Server Domain> is the name of the domain you created when you installed 
WebLogic (see Creating a WebLogic Domain on page 16 in Chapter 3: Performing Pre-
Installation Tasks).



Chapter 12 – Performing OBIEE Post-Installation Steps

136

3. Enter the administrator user name and password that you created when you set up the 
server domain (see Creating a WebLogic Domain on page 16 in Chapter 3: Performing 
Pre-Installation Tasks). The WebLogic administration console opens:

Figure 157: WebLogic Server Administration Console

4. Click the Depolyments link under the Domain Structure pane. The Deployments screen 
will open.

Figure 158: Deployments Screen
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5. Click the Install button. The Install Application Assistant screen will open.

Figure 159: Install Application Assistant Screen

6. In the Path: box, enter the path of the analytics.war file that you updated in the previous 
section (see page 125).

7. Click Enter on your keyboard. The analytics.war file will appear as one of the 
selections.

Figure 160: The Path to the analytics.war File
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8. Select the analytics.war file and click the Next button. The following screen will open.

Figure 161: Choose Targeting Style

9. Select Install this deployment as an application and click Next. The Optional Settings 
screen opens:

Figure 162: Optional Settings
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10. Scroll down to the “Source accessibility” section of the screen and select:  
 
I will make the deployment accessible from the following location.

11. Leave the rest of the settings on this screen. The deployment name should appear as 
analytics.

12. Click the Finish button.

13. After the analytics.war file has been added, you will be returned to the Summary of 
Deployments. The analytics.war file will be listed. Read the messages at the top of the 
screen and correct any errors.

14. Successful Deployment
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STEP 6: ACCESS OBIEE
1. Open a new browser window and enter the following URL for OBIEE: 

 
http://<hostname>:<port>/analytics 

2. A login screen similar to this one will appear.

Figure 163: Oracle Business Intelligence Login Screen

3. The appearance of this screen indicates that you have successfully installed OBIEE.

WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step in the installation process is to configure and deploy the ODI Wrapper Service. 
For these steps, go to:

• Chapter 10: Configuring and Deploying the ODI Wrapper Service

Note In the above URL, <hostname> can be the server name or IP address where you 
installed OBIEE (i.e., http://<hostname>:7001/analytics)
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Chapter 13

Configuring and Deploying the ODI 
WRAPPER SERVICE

The files for the ODI Wrapper Service are located under: <OII_Root>\install\wrapper

In order for the Warehouse Palette to function properly the user needs to perform the 
following steps:

STEP 1: DEPLOY THE ODI WRAPPER SERVICE .EAR
This step requires you to deploy the OdiWrapperService.ear file to WebLogic.

1. If it is not already started, start the WebLogic server from the Start Menu:

Start>All Programs>Oracle Fusion Middleware>User Projects<Your Server 
Domain>Start <Admin Server for WebLogic Server Domain>

2. Once the WebLogic server domain is running, type the following URL into your browser:

http://<hostname>:<port>/console

Note For the sake of consistency this section will refer to the default OII installation directory 
as <OII_Root>. For example:
C:\Oracle\Insight_Home\Insurance\oii\7.0.0

Table 9: Configuration Road Map

Step Description

Step 1 Deploy the ODI Wrapper Service .EAR File on WebLogic

Step 2 Create a JDBC Data Source

Note <Your Server Domain> is the name of the domain you created when you installed 
WebLogic (see Chapter 3: Installing Oracle WebLogic Server and Oracle JDeveloper on 
page 24).

Note In the above URL, <hostname> can be the server name or IP address where you 
installed WebLogic (e.g., http://<hostname>:7001/console)



Chapter 13 – Configuring and Deploying the ODI Wrapper Service

142

The WebLogic Server Administration Console login screen will open:

Figure 164: WebLogic Server Administration Console Login Screen

3. Enter the administrator user name and password that you created when you set up the 
server domain (see Chapter 3: Installing Oracle WebLogic Server and Oracle JDeveloper 
on page 24). The WebLogic administration console opens:

Figure 165: WebLogic Server Administration Console
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4. Click the Deployments link under the Domain Structure pane. The Deployments screen 
will open.

Figure 166: Deployments Screen

5. Click the Install button. The Install Application Assistant screen will open.

Figure 167: Install Application Assistant Screen

6. In the Path: box, enter the path to the file OdiWrapperService.ear:  
 
<OII_Root>\install\wrapper

For example:

C:\Oracle|Insight_Home\Insurance\oii\7.0.0\install\wrapper
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Figure 168: Enter Path to OdiWrapperService.ear 

7. Select the OdiWrapperService.ear file and click the Next button. The following screen 
will open.

Figure 169: Choose Targeting Style

8. Select Install this deployment as an application and click Next. The Optional Settings 
screen opens.
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9. Scroll down to the “Source Accessibility” section of the screen and select:  
 
I will make the deployment accessible from the following location.

Figure 170: Source Accessibility Section

10. Click the Finish button.

11. After the OdiWrapperService.ear file has been deployed, you will be returned to the 
Summary of Deployments. The OdiWrapperService.ear file will be listed. 

Figure 171: OdiWrapperService.ear File is Successfully Deployed

12. To start the service, check OdiWrapperService.ear in the Deployments table and then 
click the Start button. 
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STEP 2: CREATE A JDBC DATA SOURCE
1. On the WebLogic Server Administration Console home page, select Services>Data 

Sources. 

Figure 172: Select Services>Data Sources

The Data Sources screen opens.

Figure 173: Create New Data Source
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2. Click on the New button and select “Generic Data Source” from the drop-down list. The 
following screen opens.

Figure 174: 4. Enter JDBC Data Source Properties

3. In the JDBC Data Source Properties screen specify the following:

a. Name - In the Name field, enter the name of the JDBC data source (e.g. ODI Data 
Source).

b. JNDI Name - Give the connection the following name: jdbc/OdiDB

a. Database Type - Select Oracle.
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4. Click Next. The following screen opens:

Figure 175: Select Database Driver

5. At the Database Driver: field, select any of the Oracle Driver (thin) drivers from the 
drop-down list.

6. Click Next. The Transactions Options screen will open. The contents of this screen will 
be different depending upon which database driver that you selected on the previous 
screen. 

Figure 176: Select Transaction Options
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7. Accept whatever default options are on the Transaction Options screen and click Next. 
The following screen opens:

Figure 177: Select the Connection Properties

8. In the Connection Properties screen, enter the following:

• Database Name - Enter the Oracle SID (e.g. orcl).

• Host Name - Enter the machine name of the database (this is the name of the machine 
on which the ODI Master Repository database schema has been created).

• Port - Enter the port number used to access the database (e.g. 1521).

• Database User Name - Enter the same user name (e.g. ODI_MASTER) that you 
specified when you created the schema for the Master Repository in Chapter 11: 
Performing the ODI Post-Installation Steps (see Step 1: Create Master and Work 
Repository Schemas on page 93). 

• Password - Enter the same password that you specified when you created the schema 
for the Master Repository in Chapter 11: Performing the ODI Post-Installation Steps 
(see Step 1: Create Master and Work Repository Schemas on page 93). 

• Confirm Password - Retype your password.
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9. Click Next. The following screen appears.

Figure 178: Test the Database Connection

10. Click the Test Configuration button to test the connection. A message will appear at the 
top of the screen to indicate that a connection to the database using the properties you 
provided was successful.

Figure 179: Successful Database Connection Message
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11. Click Next. The following screen opens.

Figure 180: Select Target

12. Select the server for which the JDBC data source is to be deployed. 

13. Click Finish. You will be returned to the Data Sources screen where the new data 
source will be listed.

Figure 181: New Data Source

WHAT’S THE NEXT STEP IN THE INSTALLATION?
This completes the installation and configuration steps for OII.
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Appendix A

HP-UX Instructions
This appendix contains the instructions for performing the following post-OII installation 
tasks in an HP-UX environment:

1. Setting up security coordinations for the ODI Wrapper Service.

2. Setting up security coordinations and configuring the Warehouse Palette Agent.

SETTING UP SECURITY CREDENTIALS FOR THE ODI WRAPPER 
SERVICE

This section describes how to setup the security credentials for the ODI Wrapper Service in 
HP-UX environments.

STEP 1: EDIT THE CSUTIL.PROPERTIES FILE
1. Go to the <OII_ROOT>\app\csutil\config\ directory and locate csutil.properties file.

2. Open csutil.properties in a text editor. This file contains a single line showing the full 
path to the jps-config-jse.xml file under WebLogic.

CredentialStoreConfig=C:\\Oracle\\Middleware\\user_projects\\dom
ains\\<domain_name>\\config\\fmwconfig\\jps-config-jse.xml

Note Throughout this section we will be referring to the directory structure created during the 
OII installation. For the sake of consistency this section will refer to the default OII 
installation directory as <OII_Root>. For example:
C:\Oracle\Insight_Home\Insurance\oii\7.0.0

Note The example above shows the default name and location of the Middleware home 
directory (i.e., C:\Oracle\Middleware) and the Domain home directory (i.e., 
C:\Oracle\Middleware\user_projects\domains) as they appear in the 
csutil.properties file. These are the default locations that were created when you 
installed JDeveloper and WebLogic and created the WebLogic domain back in Chapter 
3: Installing Oracle WebLogic Server and Oracle JDeveloper. 
If you specified different locations for Middleware and Domain home directories, please 
use those directories instead of the default ones presented in the csutil.propertiesfile.
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3. Change the double-forward backslashes in this file to look like the example below and 
then replace the <domain_name> with the one you created when you initially installed 
WebLogic. For example:

CredentialStoreConfig=/data/oracle/middleware/user_projects/
domains/oii_domain/config/fmwconfig/jps-config-jse.xml

4. Save and close the csutil properties file.

STEP 2: CREATE AND RUN THE CSUTIL.SH SCRIPT
1. Create a shell script called csutil.sh with the following content:

2. Run csutil.sh at the command line.

SETTING UP SECURITY CREDENTIALS AND CONFIGURING THE 
WAREHOUSE PALETTE AGENT

This section describes how to edit the properties file that manage the security credentials for 
the Warehouse Palette agent. It also how to setup the Warehouse Palette agent to run as a 
Windows service. 

OII_CLASSPATH=
for i in ‘ls ../lib/*.jar‘
do
  OII_CLASSPATH=${OII_CLASSPATH}:${i}
done

# java must be JDK1.6 and in the path
java -cp ".:${OII_CLASSPATH}" oracle.oii.csutil.CredentialStoreUtil $1 $2 $3 $4

Note Throughout this section we will be referring to the directory structure created during the 
OII installation. For the sake of consistency this section will refer to the default OII 
installation directory as <OII_Root>. For example:
C:\Oracle\Insight_Home\Insurance\oii\7.0.0
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STEP 1: EDIT THE AGENT.PROPERTIES FILE
1. Go to the <OII_ROOT>\app\agent\config directory.

2. Open agent.properties in a text editor. The file contains these lines: 

CredentialStoreConfig=C:\\Oracle\\Middleware\\user_projects\\dom
ains\\<domain_name>\\config\\fmwconfig\\jps-config-jse.xml

JdbcUrl=jdbc:oracle:thin:@<host>:<port>:<sid>

3. Change the double backslashes so the file looks like this:

CredentialStoreConfig=/data/oracle/middleware/user_projects/
domains/<domain_name>/config/fmwconfig/jps-config-jse.xml

4. In the first line, replace <domain_name> with the name of the domain you created when 
you initially installed WebLogic. For example:

CredentialStoreConfig=/data/oracle/middleware/user_projects/
domains/oii_domain/config/fmwconfig/jps-config-jse.xml

5. On the next line, enter the applicable <host>, <port>, and <sid> for the Oracle database.

JdbcUrl=jdbc:oracle:thin:@<host>:<port>:<sid>

6. Save and close agent.properties.

STEP 2: CREATE THE WAREHOUSE PALETTE AGENT SHELL SCRIPTS
1. Create a shell script called agent_cmd.sh with the following content:

2. Create a shell script called agent_stop.sh with the following content:

Note The example above shows the default name and location of the Middleware home 
directory and the Domain home directory as they appear in the agent.properties file. If 
your Middleware and Domain home directories are different, please use those 
directories instead of the default ones presented in the agent.properties file.

OII_CLASSPATH=
for i in ‘ls ../lib/*.jar‘
do
  OII_CLASSPATH=${OII_CLASSPATH}:${i}
done
# java must be JDK1.6 and in the path
java -cp ".:${OII_CLASSPATH}" oracle.oii.wp.agent.Agent command=$1 lobCd=$2

OII_CLASSPATH=
for i in ‘ls ../lib/*.jar‘
do
  OII_CLASSPATH=${OII_CLASSPATH}:${i}
done
# java must be JDK1.6 and in the path
java -cp ".:${OII_CLASSPATH}" oracle.oii.wp.agent.Agent command=stop
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3. Create a shell script called agent_start.sh with the following content:

4. Create a shell script called agent_status.sh with the following content:

STEP 3: TEST THE WAREHOUSE PALETTE AGENT
1. Open a command prompt and go to: <OII_ROOT>/app/agent/bin

2. At the command prompt, run agent_status.sh by typing:

<OII_ROOT>/app/agent/bin/agent_status.sh

This command will show the status of all LOBs in the Warehouse Palette. If there is a 
connection problem a message will appear identifying the problem.

STEP 4: START AND STOP THE WAREHOUSE PALETTE AGENT
1. Open a command prompt and go to: <OII_ROOT>/app/agent/bin

2. Start the agent:

<OII_ROOT>/app/agent/bin/ nohup agent_start.sh

3. Open a new window and stop the agent:

<OII_ROOT>/app/agent/bin/agent_stop.sh

OII_CLASSPATH=
for i in ‘ls ../lib/*.jar‘
do
  OII_CLASSPATH=${OII_CLASSPATH}:${i}
done
# java must be JDK1.6 and in the path
java -cp ".:${OII_CLASSPATH}" oracle.oii.wp.agent.Agent command=start

OII_CLASSPATH=
for i in ‘ls ../lib/*.jar‘
do
  OII_CLASSPATH=${OII_CLASSPATH}:${i}
done
# java must be JDK1.6 and in the path
java -cp ".:${OII_CLASSPATH}" oracle.oii.wp.agent.Agent command=status
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Appendix B

Scheduling the Warehouse Palette Agent as a 
Windows Service
This appendix describes how to setup the Warehouse Palette agent to run as a Windows 
service. 

1. On your computer, open the Control Panel and select Scheduled Tasks from the list of 
options.

2. Click on Add Scheduled Tasks. This will open the Scheduled Task Wizard.

Figure 182: Scheduled Task Wizard
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3. Click Next. The Browse window opens.

Figure 183: Locate agent_start

4. Use the Browse button to find and select Warehouse Palette agent startup file:

<OII_ROOT>\app\agent\bin\agent_start.bat

For example:

C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app\agent\bin\agent_start.bat

The file name (agent_start) will appear in the following window.

Figure 184: Schedule Time to Run agent_start
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5. Select When my computer starts from the choice list and click Next. The following 
window appears.

Figure 185: User Name and Password

6. Enter a user name and password of your choice and click Next. The following window 
appears:

Figure 186: Finish Window



160

7. Click Finish. The agent_start file will appear in the list of scheduled tasks. The 
Warehouse Palette agent will now start when your computer starts.

Figure 187: agent_start is Scheduled

Note You can also start the Warehouse Palette agent by right-clicking on agent_start in 
this window and selecting Run from the pop up menu.
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